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Why Pay? Just Create Your Own Business
Cards in Microsoft Word!

Can you tell me your address? What’s your
email address? Which fax number should I
send these documents to? Whenever you’re
asked these questions, wouldn’t it be useful to
simply hand over your personal business card?

The days when you had to visit a printer to
order business cards are long gone. Using
Microsoft Word, you can design and print business cards
yourself, and simply run off a few more whenever you
need them. Read on to learn how to go about it.
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This article shows you how to:
• Choose or create a suitable template for business

cards
• Design individual business cards in Word
• Avoid potential problems when printing your

cards
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The Details to Include on Your Business Card

Whether you think of them as business cards, visitor
cards or calling cards, there are numerous benefits in
designing and printing them yourself. First, it’s vastly
cheaper than ordering them from a specialist printer.
Second, when you’re running out, you can simply print
off a few more rather than having to go back to the
printer, pay again and wait for them to arrive.

Better still, if you move house, or have a change of email
address or phone number, you won’t be throwing away
expensive cards or scribbling on them all with a pen.
You’ll just edit your business card document and print
new ones. (And that’s not to mention the satisfaction
that comes from cutting out the middleman and doing
things yourself!)

Before you start designing your business cards, take time
to do a little planning and preparation. The first thing to
do is to decide on the information you want to include
on the card. In the table opposite, you can enter the
information as you want it to appear. For example, if you
don’t want to include a website address on the card, just
leave that space empty.
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Cheaper than
professional
printing …

… and much more
flexible!

What should your
business card

include?
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One other thing you may want to think about at this
point is whether you want to include a photo or a logo
on your business card. For a photo in particular, since it
will necessarily be a fairly small size on your printed
cards, you may want to make a copy of the picture you’re
going to use (to avoid altering your original) and crop it
to remove any unnecessary background from the top,
bottom and sides so that the subject of the photo will be
clearly visible on the card.

How to Find the Right Paper for 
Business Cards

The next step is to decide what type of paper you’ll use
to print your business cards. Ordinary letter paper is
too thin and flimsy to be of any use: you’ll ideally need
to use thick paper or thin card with a weight of about
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Details Example Your information

Title Mr.

First and last names Don Levison

Street 8 Watery Lane

Town Poppleford

County Lancs.

Postcode AB1 2BC

Telephone number 01234 567890

Fax number 01234 567891

Mobile number 07901 234567

Email address don.levison@example.com

Website address www.donlevison.co.uk

Will you include
a picture?

Not too thin, but
not too thick!
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175 gsm (grams per square metre) to 220 gsm. It’s best
not to choose anything much heavier as many printers
won’t work with thick paper and tend to jam.

The standard business card size is 85 mm x 54 mm. This
means you can fit two columns of cards, with five cards
per column, on a standard A4 sheet, giving you 10
cards per page. However, if you use ordinary A4 card,
that leaves you with the tedious job of carefully
cutting out each card, unless you buy a cheap
guillotine at a stationery shop.

Rather than cutting out each card yourself, you can buy
ready-made sheets of cards that are specially designed
for the job. After printing on to these A4 sheets, you
then just have to separate them from the sheet.

These ready-made sheets of cards vary from one
manufacturer to another, but they’ll either be micro-
perforated or have a smooth edge. The perforated
cards have the disadvantage that they always have a
slightly rough, knobbly edge, even though the
perforations are very fine. The smooth-edged cards
really are just that, but they have the problem that
they don’t always work well with inkjet printers, and
may cause paper jams.

If you buy business card sheets, check first whether
they’re designed for inkjet or laser printers and make
sure you’re buying the type that suits your type of
printer. If you have an inkjet printer and you use card
designed for a laser printer, for example, you can find
that the results look smudged or rather ‘washed out’.

In the table below are 4 different packs of business
cards which you should be able to find in any good
stationery shop, as well as online retailers like Amazon
(www.amazon.co.uk). The card packs listed here are
compatible with both inkjet and laser printers:
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You can buy ready-
made business 
card sheets

Cut the card using
a guillotine
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Find a Suitable Business Card Template 
in Word

Now you’ve decided on the content of your business
cards and the card product you’re going to use, the next
step is to position your card content in Microsoft Word
so that it fits in exactly the right place on the card sheets.
The way to do this is to use a table in which each cell
corresponds to a single card on the sheet. You can then
experiment with the layout of your business cards, safe
in the knowledge that if it fits into the table cell you can
see in Word, it will fit correctly on to the printed card.
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A Word template for
your business cards

Manufacturer Card Pack

Avery
www.avery.co.uk

Business cards, white, No. C32011

25 sheets of 10 cards, 200g paper

Card size: 85 x 54 mm, smooth edges

Business cards, light grey, No. C32094

10 sheets of 10 cards, 220g paper

Card size: 85 x 54 mm, smooth edges

Decadry
www.decadry.co.uk

Business cards, white, No. OCB-3322

25 sheets of 10 cards, 175g paper

Card size: 85 x 54 mm, micro-perforations

Business cards, bright white, No. DAW-327

50 sheets of 10 cards, 200g paper

Card size: 85 x 54 mm, micro-perforations
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There are several ways in which you can generate a
document containing the correctly-proportioned table:

• Look through the business card templates on
Microsoft’s website, which offer a range of attractive
designs. These are mainly designed for sheets of Avery
cards (or cards from other manufacturers that match
a particular Avery product number).

• Use Word to generate a blank table. Microsoft Word
knows the dimensions of most popular business card
products, including the Avery and Decadry products in
the table above, and can generate them with a few
clicks.

• Create your own table from scratch. This is a slightly
fiddly job since it involves carefully measuring the
exact dimensions of your cards, and should only be
necessary if you’ve bought a card product that Word
knows nothing about, so be sure to try the option
above before resorting to this method!

If you’re planning to print your business cards on to
ordinary card and then use a guillotine (or something
similar) to cut them to size, you don’t have any
compatibility issues to worry about. You can use either
of the first two methods and simply choose any layout
that produces the number of cards-per-sheet you
want.

Follow the appropriate steps below according to the
method you’d like to use:

Find ready-to-use business card templates online

If you’d like to start with something other than a plain
sheet of empty cards, you can take a look at the business
card templates available from Microsoft. If you can find
a suitable template, it’s a quick and easy job to modify
the example text and replace it with your own details.
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Choose your
preferred method

Find ready-made
business cards at

Microsoft’s website
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Here’s what to do:

1. Start your web browser and visit this address:

http://office.microsoft.com/templates

2. When you arrive, click in the search box running
across the top of the page, type business cards and
press Enter to search.

3. Now the web page will show you examples and brief
descriptions of the available business card templates.

4. One thing this page doesn’t necessarily tell you is
which of these designs are compatible with the
business card sheets you’ve bought. The way to find
out is to click any of the examples on this page to see
more details about it. On the page that appears,
check the description to see if there’s a mention of
your card product.

5. If you find a template that fits the bill, click the blue
Download button to download it to your PC.

6. To start using the template you’ve downloaded, just
double-click it. If you see a yellow warning bar at the
top of the Microsoft Word window at this point, click
the Enable Editing button.
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Click a preview to
see a description
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7. Now you’re ready to edit the example details shown
in the template to replace them with your own, save
the result with a recognisable name and print as
many copies of it as you need.

Quickly generate a blank table for your business cards

If you can’t find a template you like on the Microsoft
website, or you’d prefer to start with completely blank
cards, follow these steps:

1. Switch to the Mailings tab on the Ribbon and click
the Labels button in the ‘Create’ group at the far
left.

2. In the dialog that appears, make sure the Labels tab
is selected, and delete any text you can see in the

large text box labelled Address .

3. Click the Options button .

1

2

3
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Generate plain
business cards

Remove text from
the Address box

2

3

1
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4. Now you’ll see the dialog pictured below. Open the
drop-down list labelled Label vendors and select the
manufacturer of the cards you bought. If you
bought an Avery product (or someone else’s product
that claims compatibility with a particular Avery
product) choose the Avery A4/A5 item; if you
bought Decadry cards, select Apli-Decadry.

5. Now, in the Product number list below, you’ll see an
alpha-numerical list of all the label and card products
available from the company you chose in the
previous step. Look down this list to find and select
the card product you bought. (A quick way to reach
the right area of the list is to click any item in the list
and then type the first letter or number of the
product you want to find, such as C if you’re using
Avery C32011 sheets.)
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Select the
manufacturer

Use Windows’
search feature
to find it
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6. Click OK to confirm your choice of label and close
this window.

7. Now you’ll find yourself back at the Envelopes and
Labels dialog you opened in step 1. Click the New
Document button. This dialog will close, and Word
will open a new document containing a large blank
table. The dimensions and layout of this table should
exactly match those of your card sheets.

Create your own business card template from scratch

If Word doesn’t recognise the brand or product number
of the card sheets you’ve bought, you can set up your
own template in Word by entering all the required
measurements. This isn’t easy (unless the measurements
are given on the packaging or on the manufacturer’s
website), as it requires some careful measuring with a
ruler and a certain amount of trial-and-error.

Follow these steps to find out which measurements
you’ll need and to enter them into Word to generate
your template:

1. Start by following steps 1 to 4 beginning on page 8
to reach the Label Options dialog.

2. At the bottom of this dialog, click the New Label
button to tell Word you want to define your own
label.

3. Below the preview of the label, in the box labelled
Label name, type a name for your business card
template that you’ll be able to recognise in future.

4. Further down, alongside Page size, select A4 (or
whichever paper size is appropriate for the card
sheets you’ve bought).

5. Now comes the tricky part! You’ll see eight boxes in
which you have to fill in the measurements of your
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You may have to
enter the

measurements by
hand

A document
containing blank
business cards

Choose a
recognisable name

Fill in the 
correct figures

PCS_8_AUGUST_2022_W509_14pp_mrg  10/06/2022  11:05  Page 76



W 509/11

cards. The Number across and Number down boxes
are easy, referring to the number of rows and
columns of cards on the sheet. The other
measurements relate to the dimensions of the cards
themselves, the top and side margins of the page,
and the distance from the left or top of one card to
the left or top of the card beside or below it. The
preview at the top of the dialog shows the
measurements you’ll need to find. 

7. Now you’ll find yourself back at the Label Options
dialog. The drop-down list of label suppliers should
now be set to Other/Custom, and in the box below
you’ll see the name you chose a moment ago for
your new cards. Make sure this new name is selected
and click OK.
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Create a blank
page of cards
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8. Back in the Envelopes and Labels dialog, click the
New Document button. This dialog will close, and
Word will open a new document containing a large
blank table whose dimensions and layout are based
on the figures you’ve just entered.

Before printing anything on to your expensive card
sheets and potentially wasting them, make sure the
dimensions of your labels are correct! Type a line or
two of text into the top-left cell, then copy and paste
the same text into all the other cells. Next, print this
page on to the cheapest, thinnest paper you have
available. When you’ve done that, place this printed
sheet over one of your card sheets, and see how this
text lines up with the cards, paying particular
attention to the cards towards the right and the
bottom of the sheet.

If you’re lucky, you’ll have entered exactly the right
figures first time, but the odds are that you’ll have to do
a little tweaking to match your newly created template
to the card sheets.

To make changes to the settings you entered, here’s
what to do:

1. Press Ctrl+W to close the template Word has
generated (which is obviously no use to you as it is),
refusing the offer of saving it.

2. Make your way back to the Envelopes and Labels
dialog and click the Options button.

3. In the Label vendors drop-down list, choose
Other/Custom.

4. In the box below, select the name you chose for your
custom layout.

5. Click the Details button below this list and you’ll see
the dialog in which you entered those measure-
ments. You can now alter any of those figures as
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You may need
to edit the

measurements

Click Details to
adjust the figures
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needed, clicking OK in this dialog and the Label
Options dialog when you’re done, and again clicking
New Document to generate another blank table
based on the new figures.

Add Your Personal Details to Your Template

Using one of the previous methods, you should now be
looking at a full-page table of blank business cards in
Word. The next step is to enter your personal inform-
ation into these empty cells.

You should be able to see pale grey or blue lines
marking out the borders of all the table cells on the
page: these are just for your own guidance and aren’t
printed on the paper. If you can’t see these lines,
switch to the Layout tabs at the far-right of the
Ribbon (or the Table Tools > Layout tab in older
versions of Word) and click the View Gridlines button
in the ‘Table’ group at the left of the Ribbon.

Exactly how you do this will depend on what
information you want to include and how you want to
format it, but follow the steps below for a general guide
and some helpful tips in achieving the result you want:

1. Begin by pressing Ctrl+A to select all the cells in the
table.

2. Using the Home tab on the Ribbon, you can select
the font you want to use. You might also choose a
particular font size, style and colour, and this will be
applied to the whole document. (Of course,
individual items of text you type can be switched to
a different font, size, style or colour later on.)

3. Now click in the top-left cell of your table to deselect
all the other cells, and you can begin typing into this
one. Although you’re typing into a table cell, you can
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Add your text to
the top-left cell
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approach this in just the same way you work on any
other document, aligning text to the left, centre or
right, and setting fonts, styles, sizes and colours. The
one difference to keep in mind is that if you need to
use the Tab key to indent text, you’ll have to press
Ctrl+Tab (the Tab key by itself takes you from the
current cell to the next).

When you want to select text you’ve typed into the
cell, you may well find it tricky using the mouse: Word
has a tendency to select text in a peculiar way in tables.
An easier method is to click to the right of the required
text, press and hold down the Shift key, and use the
left-arrow key to select the required characters.

4. If you want to include a picture in the cell, go to the
Insert tab on the Ribbon and click Pictures > This
Device to choose a picture from your own collection,
or Pictures > Online Pictures to find and select a
picture from the Internet. Don’t worry about where
the picture lands in the cell for the moment. Start by
reducing the picture to a suitable size by dragging
one of the blobs at its corners. Next, with the picture
selected, switch to the Ribbon’s Picture Format (or
Picture Tools > Format) tab, click the Wrap Text
button and choose Square. You can now drag the
picture to wherever you want it in the cell.

5. When you’re happy with the contents and layout of
your first cell, all that remains is to copy the same
content to the other cells in the table. Highlight the
entire contents of the cell and press Ctrl+C to copy it
to the clipboard, then click in the first blank cell and
press Ctrl+V to paste the same content there. You
can then work through the remaining cells pressing
Ctrl+V in each in the same way.

6. Finally, you’re ready to save your completed business
cards and print as many copies of them as you need.
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Print your cards

Copy this finished
card to the
empty cells

How to add and
position a picture
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